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Flash basics

First

1. Click on the first frame, to activate it. The circle changes from empty to filled.

2. Drawn objects always have an outline. So mark the outline and press DEL.

For zooming: there is a magnifying glass in the toolbox.

The smoothness of movies can be adjusted as follows:

Modify menu


Movie. The default of 12 BpS* is OK.


Note you can also adjust the size of the Stage here.

* Then 12 frames = 1 second

Marking objects

Mark objects with the lasso.

Z-order of objects

Shift the objects’ layers in the timeline up or down. Shifting up -> object appears on top.

Accelerating download times

Always convert objects to symbols. ONLY symbols have an outline, and have a + in the middle.

Recommended site: www.balthaser.com
Flash is THE way to add sounds without long download times?

Production

movie done
export
format = 


HTML document

upload to

(*.fla)
(p. 139)
Shockwave Flash
in Dreamweaver 

server 


(*.swf)
or Aftershock
(p. 174)


(p. 143, 162)

Exporting

1. Save as a Flash movie (*.fla). Keep this file, because you might need to edit it later! The *.sw cannot be edited.

2. File/Export
The following options are recommended: 

Load order Top down

Protect from import: No

The HTML project requires only the *.swf file.

Export options

trade-off quick download vs. quality: Control > Settings

Testing movies in player

Control > Test Movie.

Use Window to switch between the real movie and regular Flash.

p. 28, 131, 145

Testing downloading performance

p. 146

Exporting

p. 147-8

Importing into Dreamweaver

See the Dreamweaver manual, p. 88

Exporting as a non-interactive animated GIF

p. 153. Only the PNG format supports transparency, so alpha channel effects will NOT show up on an animated GIF version of the movie!

Viewing Shockwave Flash movies

(*.swf files)

In

· browser with the Shockwave Flash Player (see Flash Readme file)

· with the Flash ActiveX control in Director, Authorware, MS Office

· RealPlayer version 5 or later

· a stand-alone application called a projector (see p. 150 and Flash Readme file)

The Shockwave Flash player

p. 150; p. 12 top, see URL. For example as a give-away.

The plug-in

is called NPSWF32.dll, and is located in F:\Flash 3\Players

Flash techniques

Selecting a frame

Click in a layer's space, NOT at the top of the timeline!

Importing a scanned-in image or other bitmap

p. 74

Converting bitmaps to vector graphics

p. 75

Magic wand

p. 76

Transparency

Modify > Instance

Instance Properties

Color Effect

Color Effect: Alpha

adjust the slider to < 100%

See also p. 58, 60, 108, 7 top, Index for alpha settings and for transparency

The Library

Contains the symbols created for one specific movie.

Text can be converted to a symbol and added to the library:

· Select the text

· Insert menu


Convert to symbol

Editing symbols

· Select the symbol in the library window

· Double-click on it when it appears in the upper portion of the library window

This way, text can be edited even if it has been converted to a symbol!

Making objects appear and disappear entirely

1. Create a separate layer for the object

2. Create initial and final keyframes

3. Click on the initial keyframe

4. Create something in that layer

The thing will disappear after the final keyframe.

Example: Gabriele.fla: the messages

Animation

· Objects to be animated MUST be symbols

Insert > Create Symbol, or F8

· Each animated object must be on its own layer

Show objects statically for a while, without tweening

Go to where static display is to stop, insert an empty keyframe (F5)

Animating text

p. 73

Text moves along a path

1. At the final frame, create a keyframe

2. Write text

3. Mark it and convert it to a symbol (Insert menu)

4. On the timeline layer for the text, right-mouse click in the name area

5. Select Add Motion Guide
A new layer for Guide will appear, with a rainbow arc

6. Select the Motion Guide layer

7. Select the Pencil tool, and draw a motion path

8. Switch to the text layer

9. With Zoom, place the + center of the text exactly on the beginning of the path

10. Go to the last frame (a keyframe)

11. With Zoom, place the + center of the text exactly on the end of the path

12. Click on the symbol twice

13. Specify Tweening: motion

Motion tweening

p. 86

motion tweening

color effects

alpha effects

size tweening

rotation tweening

Important

Objects MUST be symbols or groups.

1. Select the object

2. Insert menu

Convert to symbol

· To define the motion path, make sure the object's layer is the current layer.

· First frame: add an object

· Go to the final frame. Make it a keyframe (F6)

· Move the object to a different location

· If the new object is a letter, mark it. In the menu Modify, select Break Apart

· Go to first keyframe

· Double-click (or right mouse button): Frame Properties

· Tab Tweening: select Motion; OK

Color tweening

· Click on the symbol twice (not on the frame) -> Instance Properties

· Select the Color Effect tab

· Experiment with all of the options, such as Alpha and Special

Special shifts the color components.

Shape tweening

p. 91

shape tweening

(color tweening ???)

motion tweening

NO size tweening

Symbols and groups CANNOT be shape tweened

First frame: add an object

· Go to the final frame. Make it a keyframe (F6)

· Modify the existing object, or delete it and add a new one

· If the new object is a letter, mark it. In the menu Modify, select Break Apart

· Go to first keyframe

· Double-click (or right mouse button): Frame Properties

· Tab Tweening: select Shape; OK

Tweening to letters: Quite different transformations can be obtained by adding a small line which breaks up the continuity of the letter.

Tweening symbol colors

This uses motion tweening.

1. The object MUST be a symbol. For this to work, you might have to select the object, then use the right mouse button to select Properties?
2. P. 108-9: you must create a keyframe for the symbol's layer. Do this by clicking on the last frame at the height of the symbol's layer. If you do this right, after clicking you will see a separate dot for this layer.

Simply clicking on the frame does not necessarily create a keyframe for the 

desired layer.

3. Select the object at both the final and initial frames. When it is selected, there will be a black dot beside its layer's name. Make sure no other symbol/object is also selected.

4. In Modify > Frame > Tweening, select motion tweening.

See the sample file E:\My Documents\Web sites\Flash\Flash movies\Tweening symbol colors.fla

Both shape and motion tweening


shape tweening, such as motion and shape tweening.fra

Select shape tweening.

Sounds

Importing sounds

via File/Import

Import sounds from:

G:\My Documents\Web sites\Macromedia\Flash\sounds

Have all sounds in the Flash file all sounds.fla. Try sounds out there.

Accessing the new sounds

via Window


Library

NOT via Libraries



Sounds

Adding sounds

1. Create a new layer for sound(s)

2. Add a keyframe where you want the sound

3. Select Libraries/Sound

4. In the Library window for sounds, select a sound.

5. Drag it from the Library upper pane to the Stage

Adjusting sound quality, etc.

1. In the sound layer, double-click on a frame where a sound occurs
(or click + right mouse button)

2. In the Frame Properties window, select the Sound tab

3. Recommended settings:

MP3 compression

Bit rate: 8 or 16 kbps.

Override sound settings: CHECK (yes)

Note

The sounds in the Sounds library can be edited, by double-clicking on one (or right mouse button, then Properties). The sounds supplied with Flash seem to be write-protected, so they cannot be edited.

Adjusting sound properties of the finished movie

1. File/Export movie

2. Save as a *.swf file. After you specify a name, the next window allows you to readjust the sound properties.

The sounds in a Flash movie can be edited in Sound Forge, even after the movie is finished.

Masks

1. Create a final frame, as a keyframe

2. Create something to be shown, such as a text

3. Create a new layer

4. In the timeline new layer, right-click in the name area

5. Select Mask. The symbol shown in the name area of this layer is a down arrow in a circle.

6. Select the mask layer (if not already selected)

7. Create a circle. It must be monochrome, and not a symbol

8. Place the circle at the beginning of the message

9. Go to the final frame

10. Place the circle at the end of the message

11. Double-click the initial keyframe for the circle
12. Specify Tweening: Shape

13. In the name area of the message’s layer, with the right mouse button, specify Mask
14. In the name area of the circle’s layer, with the right mouse button, specify Show Masking
Color gradients

Window menu


Color

All changes relate to the current project ONLY.

Onion skins

At bottom of timeline.

Use these options to show all motion changes. The changes are displayed for the frames delimited by the onion markers.

Interaction!

Formalities

Selecting vs. activating buttons

p. 114

Testing interactivity

p. 131

Not all interactive features are previewed in the authoring environment.

Surest way to test:

1. If you attached actions to frames: Control > Enable Frame Actions

2. If you attached actions to buttons: C ontrol > Enable Buttons

3. Control > Test Movie

Attaching actions to buttons

p. 116

You can display a new movie, jump to a new frame, branch to a new Web site, animate buttons or add sounds.

1. Draw a circle

2. Mark it

3. Insert menu

Convert to Symbol

For Behavior, specify Button!

4. Open this button in the Library (Window menu/Library)

5. Double-click on it, to edit it

6. Note that the frames in the new timeline are quite different

7. Select the frame Over; insert a keyframe here
8. Select the Paint Bucket and a different color. Repaint the button

9. Repeat steps 7 and 8 for the frames Down and Hit

For Down, it is a good idea to change the button’s size, shape and color.

For Hit, you define the active area of the hotspot. The surface must be monochrome (no color gradient).

10. Control menu

Enable Buttons

11. Control menu

Test Movie

12. Run your mouse over the button to test it; and click

Notice step 11 simply opens a new window, which you can close after the test.

Adding sounds to buttons

1. Perform the above steps

2. Edit the button (above steps 4 and 5)

3. Select the frame Over (or another one); insert a keyframe here
4. Open the Sounds library

5. Select a sound

6. Drag and drop the sound wave to the button on the Stage

7. Return to the scene; test the sound of the button by clicking on it

Adding functions to buttons

1. Create a button

2. Control menu

Enable Buttons OFF
3. Double-click on the button, to edit it

4. Select the tab Actions

5. Click on + to add an action

Get URL: select _blank to open a new window

Attaching functions to keyframes

The functions possible for buttons can also be added to keyframes.

1. Double-click on a keyframe

2. Select the tab Actions 

Display a new movie

p. 120 Load Movie, p. 119 Play

Jump to a new frame

p. 119 Go To

Example: Gabriele.swf

Branch to a new Web site

p. 119 Get URL

Animated button

p. 128

Sounds

p. 139

Attaching actions to frames

You can display a new movie, jump to a new frame, branch to a new Web site, animate buttons, add sounds, create pauses, or have a movie load another one.

p. 118

Display a new movie

p. 120 Load Movie, p. 119 Play

Jump to a new frame

p. 119 Go To

Example: Gabriele.swf

Good: Go To and Play

Branch to a new Web site

p. 119 Get URL

Animated button

p. 128

Sounds

p. 139

Create pauses

p. 119 Stop

A movie loads another movie

p. 120 Load Movie

Documentation of all possible actions

p. 119-120

Menus

p. 128

3-D

The products are:

Vecta 3D, at www.buyonet.com/vecta3d
Swift 3D, at www.swift3d.com
Ideas to implement

Paths

*.fla files are in G:\My Documents\Web sites\Macromedia\Flash\Flash movies

*.wf files are in G:\My Documents\Web sites\Macromedia\Flash\Flash movies

1. Catch the flying hyperlink!
manual, p. 88

2. Ken’s testimonials

4. Combine with WebCam

5. Poems whose words move, change color. Add interactivity!!!

6. User selects one Flash movie from a drop-down menu. The movies all play on the page with the menu (site does not branch to a new page).

· show/hide layer

· onClick -> play movie

7. Drop-down list selects one Flash movie. Each movie is on a separate layer. The movie plays on the page with the drop-down list:

· Dreamweaver function hide/show layer

· Does Dreamweaver have a function for Play Flash movie?

2. Photo of my Mom's new auto, with sound track of the Beach Boys, "Four-oh-nine"

2. An invisible hand writes the words of a message, like airplane movie

3. Multimedia quiz

with pix, sounds, instant grading

Example: Who is the most popular person of this century?

With several pix, one shakes slightly ("take me")

4. Political ad for a candidate

Sounds= candidate's voice, with sound bites on various issues

5. Site give-away is the Shockwave Flash player

p. 12, top see URL; p. 143. The plug-in is called NPSWF32.dll, and is located in:

F:\Flash 3\Players

5. Animation of electronics processes

cap charging …

6. a movie dedicated to the subject of G
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2

